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Introduction 

How to Use this Book 

Welcome to the RISA-2D ¦ǎŜǊΩǎ DǳƛŘŜ. If you are a first-time user of RISA-2D, we recommend that you 
start with this book. This book contains step-by-step tutorials that guide you through the entire modeling 
process using most RISA-2D features. You will create a real-world example of building and solving a 
model, making changes, and optimizing the model. Several tips and shortcuts will also be demonstrated 
along the way.  

Begin by reviewing First Look at RISA-2D on page 9 to familiarize yourself with the RISA-2D menus, 
toolbars, and shortcuts. Then proceed to the step-by-step tutorials. There is also a handy reference 
included as Appendix A  ς RISA-2D Toolbar Button Quick Reference to help you reference toolbar buttons. 

To complete all the tutorials will take only a few hours. However, you can speed up the process even 
further if you skip the supporting text and concentrate only on the action steps, which are indicated with 
diamond-shaped bullets, as shown below: 

 In order for you to achieve accurate results, it is important that you do not miss any of these 
action steps while performing the tutorials. 

The tutorials build upon themselves from start to finish. You have the option of performing them all at 
one time, or performing each one separately. To make this possible, RISA provides model files for you to 
load at the beginning of each tutorial. These starter files are located in the RISA folder under Tutorials, 
and are named RISA-2D Tutorial 2 Starter.r2d, RISA-2D Tutorial 3 Starter.r2d, etc. 

After you have completed the tutorials in this guide, you can use the Help Menu and RISA-2D General 
Reference for complete, detailed information on every topic relating to RISA-2D. The topics are 
thoroughly indexed for quick reference.  

If you are a more experienced user and are not sure which book will be most helpful for your situation, 
consider that the RISA-2D ¦ǎŜǊΩǎ DǳƛŘŜ covers how and when to apply RISA-2D features such as slab 
design strips, but the specifics of how those strips effect the design of your reinforcement are covered in 
the Help Menu and the RISA-2D General Reference.  

Where to Download RISA-2D Book Updates 

Every effort has been made to ensure the accuracy of this book at the time of publication. The latest 
edition of all books and documents relating to this product are available in Adobe PDF format at 
http://www.risatech.com. Click Downloads, Product Documentation, then RISA-2D. 

  

http://www.risatech.com/
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Document Conventions 

The following conventions are used throughout this book: 

This convention: Indicates: 

CAPITAL LETTERS Names of keys on the keyboard ς for example, SHIFT, CTRL, or ALT. 

KEY+KEY One key should be held down and then another key pressed ς for example, 
CTRL+P or ALT+F4. 

Bold text 

Boxed text 

  

User interface options ς for example, File menu. 

Notes or modeling tip information. 

Tutorial action item for building the model. 
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Using the Online Help 

Whether you need help on general topics, specific features, or toolbars, it is all built in to the extensive 
RISA-2D online Help system. The RISA-2D Help was designed to enable you to pinpoint the Help 
information you need quickly, by offering different ways for you to access and locate that Help, as 
described below: 

 

Help on  
general topics 

On the RISA toolbar, click the Help button . This is the fastest way to get 
help on general topics. You can also go to the main menu and click Help, 
then select Help Topics. 

Once you enter the Help, notice the three tabs on the left: Contents, Index, 
and Search. You can explore the Help by topic using either Contents or 
Index, or use Search to explore the Help with your own specific keywords. 

 

Help on a specific 
feature (context-
sensitive help) 

As you work, notice the Help buttons at the bottom of many of the dialog 
boxes. These provide direct access to the Help information related to the 
task you are performing.  

This context-sensitive help may be accessed by pressing the Help button on 
the dialog box or by pressing the F1 key. 

 

Help on toolbar 
buttons 

Are you uncertain what a toolbar button is for? Simply hold your mouse 
pointer over that button (without clicking), and a description of that button 
will be displayed.  

 

  



Introduction 

4 

Technical Support Information 

Technical support is an integral part of the software packages offered by RISA Technologies, and is 
available to all registered licensees at no additional charge for the life of the program. ¢ƘŜ άƭƛŦŜ ƻŦ ǘƘŜ 
ǇǊƻƎǊŀƳέ ƛǎ ŘŜŦƛƴŜŘ ŀǎ ǘƘŜ ǘƛƳŜ ǇŜǊƛƻŘ ŦƻǊ ǿƘƛŎƘ ǘƘŀǘ ǾŜǊǎƛƻƴ ƻŦ ǘƘŜ ǇǊƻƎǊŀƳ ƛǎ ǘƘŜ current version or 
until the program is discontinued. In other words, whenever a new version of RISA-2D is released, the life 
of the previous version is considered to be ended. Technical support is a limited resource; first priority 
will always be given to those clients who are current on their maintenance. For more information, please 
see Maintenance on page 8.  

RISA Technologies will only support the current version of RISA-2D. For a list of your support options, visit 
our website: www.risatech.com/support. 

Before contacting technical support, you may want to take a few minutes to do the following: 

 Search the Help menu and all user documentation available for the product.  

 Search our FAQ database by visiting our website at http://www.risatech.com. Click Support, 
then Frequently Asked Questions, and then choose the product. 

When you are ready to make a support request, please be prepared to send us your model, and include 
the following information: 

 Your name, company name, and phone number;  

 Product name and serial number or Key ID;  

 A detailed problem description; and  

 Your model (filename.r2d) as an e-mail attachment, or on disc if sending via mail. If your 
model contains multiple members, or load combinations, please specify which ones we 
should look at.  

You can contact Technical Support by e-mail, phone, or by mail, as follows: 

E-mail: support@risatech.com 
E-mail is usually the best way to communicate with us when sending a model. Please include all the 
information listed above. 

Phone: (949) 951-5815 or (800) 332-RISA (7472) 
Technical support personnel are available from 6:00 A.M. to 5:00 P.M. Pacific Standard Time, Monday 
through Friday.  

Mail:  
If you prefer support via mail, please enclose all information listed above, and mail to:  
RISA Technologies, Technical Support 
26632 Towne Centre Drive, Suite 210 
Foothill Ranch, CA 92610 

RISA Technologies Online 

Visit RISA Technologies on the Worldwide Web at http://www.risatech.com for:  

 Answers to frequently asked questions 

 Technical Solutions blogs 

 Downloads of user documentation and tutorials  

 Software updates ς Any known problems are posted on the website, along with possible 
work-around procedures and/or service releases to update your software

http://www.risatech.com/support
http://www.risatech.com/
mailto:support@risatech.com
http://www.risatech.com/
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Before You Begin 

RISA-2D Overview 

Using computer software to perform structural design is essentially a three-step process. First, you define 
your model. Next you solve that model to obtain solution results. Last, you review those solution results 
to see how your model performed and determine if changes are needed. Usually you will need to repeat 
the cycle several times before you arrive at a final design. RISA-2D has been developed to make the 
definition, design, and modification of structural systems fast and easy.  

Because of its unique ability to define the model and make revisions both graphically (using the drawing 
tools) and numerically (using the customized spreadsheets), RISA-2D is able to significantly speed up the 
design process. 

In RISA-2D, these two methods of entering and editing data work seamlessly together. Everything drawn 
graphically is automatically recorded in the spreadsheets (which may be viewed and edited at any 
time)τand everything entered in the spreadsheets may be viewed and edited graphically at any time. 
The model can be rapidly edited, solved, viewed, modified, re-solved, etc. As you perform the step-by-
step tutorials in this guide, you will be exploring both methods. 

Hardware Requirements 

Minimum 

 Any Windows compatible computer with a Pentium 3 Processor or better  

 Windows XP/Vista/7 

 256MB of RAM 

 200MB of hard disk space 

 Two or three button mouse 

 USB port (required for Stand-Alone version or Network Host computer) 

Recommended 

 Windows XP 

 As much extended RAM as possible 

 As much free disk space as possible 

 Two button mouse with wheel 

Note: The amount of space required by RISA-2D to solve a structural model is dependent on the size of 
the model. In general, 500 MB of RAM is adequate to solve most problems, but the more the better, 
especially for large models. RISA-2D will use as much available RAM as possible. If there is not enough 
RAM, RISA-2D will use hard drive space until enough memory is obtained to solve the problem (causing 
the solution to run much slower). 
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Program Limits  

Joints 1000 

Members 1000 

Plates 1000 

Materials 500 

Section Sets 5000 

Custom Wood Species 500 

Basic Load Cases 1000 

Loads 10000 

Moving Loads 1000 

Load Combinations 1000 

Mode Shapes 500 

  

Demonstration Version: While you can open and solve a larger model, the largest model that can be 
saved to disk with the demonstration version is limited to 20 Joints, 20 Members, 20 Plates, and 1 Wall 
Panel. 
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License Agreement 

END-USER LICENSE AGREEMENT FOR RISA TECHNOLOGIES® SOFTWARE 

The RISA-2D software product (SOFTWARE PRODUCT) includes computer software, the associated media, any 
printed materials, and any electronic documentation. By installing, copying or otherwise using the SOFTWARE 
PRODUCT, you agree to be bound by the terms of this agreement. If you do not agree with the terms of this 
agreement RISA Technologies is unwilling to license the SOFTWARE PRODUCT to you. In such event you must delete 
any installations and destroy any copies of the SOFTWARE PRODUCT and return the SOFTWARE PRODUCT to RISA 
Technologies within 60 days of purchase for a full refund. 

Copyright 2010 by RISA Technologies, LLC. All rights reserved. The SOFTWARE PRODUCT is protected by United 
States copyright laws and various international treaties. All rights not specifically granted under this agreement are 
reserved by RISA TECHNOLOGIES. 

1. SOFTWARE LICENSE. The SOFTWARE PRODUCT is licensed, not sold. All right, title and interest is and remains 
vested in RISA TECHNOLOGIES. You may not rent, lease, or lend the SOFTWARE PRODUCT. You are specifically 
granted a license to the use of this program on no more than one CPU at any given time. The Network Version of 
the SOFTWARE PRODUCT is licensed for simultaneous use on a certain maximum number of network stations that 
varies on a per license basis. As part of the license to use the SOFTWARE PRODUCT, the program user acknowledges 
the reading, understanding and acceptance of all terms of this agreement. The SOFTWARE PRODUCT may not be 
reviewed, compared or evaluated in any manner in any publication without expressed written consent of RISA 
Technologies. You may not disassemble, decompile, reverse engineer or modify in any way the SOFTWARE 
PRODUCT. If the SOFTWARE PRODUCT was purchased at a discounted price for educational purposes it may in no 
event be used for professional design purposes. The terms of this license agreement are binding in perpetuity. 

2. DISCLAIMER. We intend that the information contained in the SOFTWARE PRODUCT be accurate and reliable, but 
it is entirely the responsibility of the program user to verify the accuracy and applicability of any results obtained 
from the SOFTWARE PRODUCT. The SOFTWARE PRODUCT is intended for use by professional engineers and 
architects who possess an understanding of structural mechanics. In no event will RISA Technologies or its officers 
be liable to anyone for any damages, including any lost profits, lost savings or lost data. In no event will RISA 
Technologies or its officers be liable for incidental, special, punitive or consequential damages or professional 
malpractice arising out of or in connection with the usage of the SOFTWARE PRODUCT, even if RISA Technologies or 
its officers have been advised of or should be aware of the possibility of such damages. RISA TECHNOLOGIES' entire 
liability shall be limited to the purchase price of the SOFTWARE PRODUCT. 

3. LIMITED WARRANTY. RISA Technologies warrants that the SOFTWARE PRODUCT will operate but does not 
warrant that the SOFTWARE PRODUCT will operate error free or without interruption. RISA Technologies sole 
obligation and your exclusive remedy under this warranty will be to receive software support from RISA 
Technologies via telephone, e-mail or fax. RISA Technologies shall only be obligated to provide support for the most 
recent version of the SOFTWARE PRODUCT. If your version of the SOFTWARE PRODUCT is not the most recent 
version RISA Technologies shall have no obligation to provide support in any form. Except as stated above the 
SOFTWARE PRODUCT is provided without warranty, express or implied, including without limitation the implied 
warranties of merchantability and fitness for a particular purpose.  

4. PROTECTION DEVICE. In the event the SOFTWARE PRODUCT requires the use of a PROTECTION DEVICE to 
operate, you are specifically prohibited from attempting to bypass the functionality of the PROTECTION DEVICE by 
any means. If the PROTECTION DEVICE becomes broken or inoperable it should be returned to RISA TECHNOLOGIES 
for a replacement. The replacement will not be provided if RISA TECHNOLOGIES can not affirm that the broken 
PROTECTION DEVICE was originally provided by RISA TECHNOLOGIES for use with the SOFTWARE PRODUCT. A lost 
or stolen PROTECTION DEVICE will not be replaced by RISA TECHNOLOGIES. 

5. TERMINATION. RISA TECHNOLOGIES may terminate your right to use the SOFTWARE PRODUCT if you fail to 
comply with the terms and conditions of this agreement. In such event you must delete any installations and 
destroy any copies of the SOFTWARE PRODUCT and promptly return the SOFTWARE PRODUCT to RISA 
Technologies. 
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6. CHOICE OF LAW. By entering into this Agreement in accordance with Paragraph 1, above, you have agreed to the 
exclusive jurisdiction of the State and Federal courts of the State of California, USA for resolution of any dispute you 
have relating to the SOFTWARE PRODUCT or related goods and services provided by RISA Technologies. All disputes 
therefore shall be resolved in accordance with the laws of the State of California, USA and all parties to this 
Agreement expressly agree to exclusive jurisdiction within the State of California, USA. No choice of law rules of any 
jurisdiction apply. 

"RISA" as applied to structural engineering software is a trademark of RISA Technologies, LLC. 

Installation 

Installation Instructions 

To install RISA-2D, please follow these instructions: 

 Place the RISA-2D CD in your computer CD drive. If the CD starts automatically, skip the 
remaining steps, and follow the on-screen instructions. 

 If the CD does not start after 10 seconds, click the Windows Start button and click Run. 

 In the Run ŘƛŀƭƻƎ ōƻȄΣ ǘȅǇŜ άd:\ launchsetupέ όǿƘŜǊŜ άdέ ƛǎ ǘƘŜ ƭŀōŜƭ ƻŦ ȅƻǳǊ /5 ŘǊƛǾŜύΣ ŀƴŘ 
then click OK. 

 Follow the on-screen instructions. 

RISA-2D CustomizationςImportant Assumption! 

Please ensure that when performing these tutorials, RISA-2D has not been customized in any way, and is 
in the default, installed state. If the installation of RISA-2D has been customized, you may reset the 
program defaults as follows: on the Tools menu, click Reset All Program Defaults. 

Maintenance 

Program maintenance provides all upgrades to RISA-2D, discounts on new products, and top priority for 
technical support. 

When your maintenance expires, you will be given the opportunity to continue program maintenance on 
an annual basis. You are under no obligation to continue program maintenance, of course, but if you 
decide to discontinue maintenance you will no longer receive RISA-2D program upgrades and you will not 
be eligible for technical support once the version of the program you ended with becomes obsolete. 
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First Look at RISA-2D 

Starting RISA-2D 

This section describes the RISA-2D user interface, the toolbars, and shortcuts. We recommend that you 
review this section before you begin the tutorials. 

Start RISA-2D as follows: 

 On the Start button, click All Programs, select RISA, then select RISA-2D. 

Windows and Dialog Boxes 

When you first start up RISA-2D, you will be presented with the following screen: 

 
  

Minimize  Maximize  Close 

Status Bar 

Starting a Model 
dialog box 

Workspace 
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Title bar The title bar at the top of your RISA-2D window can be very useful. Besides containing the 
name of the file that is currently open, it can also be used to move the window and 
minimize, maximize, and resize the window.

 

To move the window, press and hold the title bar with your mouse, then drag to the desired 
location.  

Minimize, 
Maximize, 
Close 

The three buttons  on the right of the title bar control the RISA-2D window as 
follows: 

 Click Minimize   to minimize the window to a button on the taskbar. 

 Click Maximize  to maximize the window to full screen. Once it is full screen, 
click Restore Down  to restore the window down to its original size. 

 Click Close  to close the window. 

Workspace The actual work that you do in RISA-2D will be in the main area on the screen, the 
workspace. Currently the workspace is empty except for the Starting a New Model dialog 
box. As you create new model views and spreadsheets they will also appear in the 
workspace.  

Status bar The Status bar at the bottom of your screen will report information about your model as you 
work. 

 LŦ ǘƘŜ ƭŜǘǘŜǊ ά{έ ƛǎ ŘƛƳƳŜŘΣ ŀ ǎƻƭǳǘƛƻƴ Ƙŀǎ ƴƻǘ ōŜŜƴ ǇŜǊŦƻǊƳŜŘΦ !ŦǘŜǊ ŀ ǎƻƭǳǘƛƻƴ Ƙŀǎ ōŜŜƴ 
ǇŜǊŦƻǊƳŜŘΣ ǘƘŜ ƭŜǘǘŜǊ ά{έ ǿƛƭƭ ōŜŎƻƳŜ ōƭǳŜ ƛƴ ŎƻƭƻǊ ǿƛǘƘ ŀ red checkmark (as shown below). 
LŦ ǘƘŜ ά{έ ƛǎ ȅŜƭƭƻǿΣ ǘƘƛǎ ƳŜŀƴǎ ȅƻǳ ƘŀǾŜ ǎƻƭǳǘƛƻƴ ǊŜǎǳƭǘǎ ōǳǘ ǘƘŜǊŜ ƘŀǾŜ ōŜŜƴ ƳƻŘƛŦƛŎŀǘƛƻƴǎ 
via the Member Redesign dialog box. 

 

¢ƻ ǘƘŜ ǊƛƎƘǘ ƻŦ ǘƘŜ ά{έ ŀǊŜ о ǎǘŀǘǳǎ ōƻȄŜǎΥ 

 The first status box displays general information relative to the task you are 
performing. 

 The second (middle) status box reports the units of the current spreadsheet cell. 
As you move from cell to cell, look to the middle status box for the appropriate 
units. This box is empty if you are not working in a spreadsheet. 

 The third status box (on the far right) reports the cursor coordinates as you work 
in the model view. This will be demonstrated throughout the tutorial. 

Dialog 
boxes 

Dialog boxes are windows that help you perform a specific function within RISA-2D. For 
example, the Starting a Model dialog box is presented when you first open RISA-2D, which 
helps you find the file you wish to open.  
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Menus and Toolbars 

Main Menu 

 

The Main menu and its submenus provide access to all features RISA-2D has to offer, as summarized 
below: 

File Provides access to file operations such as opening, saving, and exporting files. 

Edit Provides editing tools that help you modify and manipulate the spreadsheets. 
You may use this menu to add or remove information from the spreadsheets or 
to sort and mathematically manipulate current spreadsheet data. 

Global Provides access to the Global Parameters dialog box which may be used to 
modify global solution and design settings. 

Units Allows you to set units or convert existing units. 

View Allows you to open a new model view or adjust the current model view. 

Insert Used to insert drawing grids, slabs, beams, footings, and loads into the model. 
All of these items may be drawn graphically or entered in the spreadsheets. 
This menu provides access to the graphical methods that RISA-2D provides, 
while the Spreadsheets menu gives you access to the spreadsheets. 

Modify Allows access to the graphic editing features and may be used to modify 
existing model elements. 

Spreadsheets Opens the spreadsheets. 

Solve Solves the model. 

Results Allows access to all analysis result spreadsheets. This button is dimmed when 
no results are available, such as before you run a solution. 

Tools Provides tools to help you organize, identify, and correct problems as you 
model the structure. Program Preferences are also located here. 

Window  Manages all of the windows that you have open in RISA-2D, whether they are 
spreadsheets or model views. Special tiling options are also available that 
relate to specific modeling tasks. 

Help Provides access to the RISA-2D online Help menu. For more information on 
Help, see Using the Online Help on page 3. 
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Toolbars 

The most commonly used features available on the Main menu are also available on the toolbars as 
toolbar buttons. The toolbars are designed to speed up your workflow by placing these tools close to 
your workspace and making them easily visible.  

Unlike some of the other toolbars, the RISA toolbar never changes.The other toolbars change, depending 
on whether you are in model (graphical) view or spreadsheet view. 

 

 

If you are not sure what a particular toolbar button does, simply position your mouse over the button 
and a short definition will display. 

Note: You will discover many methods of accessing the tools available in RISA-2D. The methods you 
chooseτwhether menus, toolbars, or keyboard shortcutsτwill simply be a matter of personal 
preference. 

Window toolbar ς any time a 
spreadsheet is open, notice 
the window toolbar changes 

Selection toolbar - 
is not visible in 
spreadsheet view 

In Spreadsheet View 

Window toolbar  
(in Model View) ς contains 
viewing commands 

Data Entry toolbar - provides quick 
access to spreadsheets (then toolbars 
switch to spreadsheet view) 
-AND/OR-   
Results toolbar - After the model is 
solved, the results are displayed here 

RISA toolbar ς provides access to file operations, 
printing, changing design parameters, etc. 

Drawing toolbar -  
Toggle on with (CTRL+G) 

Selection toolbar ς 
provides tools to 
help make selections 

Main menu 

In Model View 
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RISA Toolbar  

 

The RISA toolbar is located directly below the Main menu. Unlike some of the other toolbars, the RISA 
toolbar never changes. These buttons perform general actions such as opening and closing files, changing 
design parameters, printing, and solving the model.  

Window Toolbar  

Χƛƴ aƻŘŜƭ ±ƛŜǿ 

 

The Window toolbar is located directly below the RISA toolbar. When working in a graphic model view, 
the buttons provide model viewing tools, such as rotate and zoom, and others. 

Χƛƴ {ǇǊŜŀŘǎƘŜŜǘ ±iew 

 

When you are working in a spreadsheet, this toolbar provides spreadsheet editing tools, such as Sort, 
Block Fill and Block Math. 

Drawing Toolbar  

 

The Drawing toolbar provides tools to assist with creating and modifying your model graphically. This 
toolbar may be turned on and off (CTRL+G) as needed. 

Selection Toolbar  

Χƻƴƭȅ ǾƛǎƛōƭŜ ƛƴ aƻŘŜƭ ±ƛŜǿ 

 

The Selection toolbar is the vertical toolbar along the left side of the screen.  
It provides tools to help you select and unselect parts of the model.  
You will need to make selections when you do things like graphically edit a  
part of the model or print only part of the results.  
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Spreadsheet Toolbars  
(Data Entry and Results Toolbars)  

These two toolbars provide access to the spreadsheets. You 
can turn them on and off on the RISA toolbar by clicking the 

Data Entry button  or the Results button . 

The Data Entry toolbar is a vertical toolbar on the right of your 
screen. It looks different than the other toolbars because its 
buttons consist of text instead of images.  

The Results toolbar is very similar. It appears after the model 
has been solved and provides quick access to the results 
spreadsheets. 

Both toolbars allow you to access the spreadsheets very 
quickly while building and solving your model. The buttons 
appear in the general order as you may need them.  
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Managing Windows, Model Views, and Spreadsheets 

Managing Windows 

As you work in RISA-2D, you will be working within model views and spreadsheets, each in their own 
window that may be moved around the workspace and resized as you wish. A powerful feature of RISA-
2D is the ability to have multiple model views and spreadsheets open at one time. The Window menu 
provides many options to help manage the display of these windows. 

 

Managing Model Views 

You may open as many model view windows as you like. This is especially helpful when working zoomed 
in on large models. You might have one overall view and a few views zoomed in and rotated to where 
you are currently working. You may have different information plotted in each view. 

Remember that the toolbars displayed by RISA-2D vary depending on which window is active (the 
window with a colored title bar is the active window).  

For example, if your active window is a 
spreadsheet, and you are looking for the 
zoom toolbar, you will not be able to 
locate it until you click your model, 
switching to model view. Then you will 
be able to access the zooming tools, and 
all the other tools related to modeling. 

  

Scroll bar - to view information 
ƻǳǘǎƛŘŜ ƻŦ ǘƘŜ ǿƛƴŘƻǿΩǎ ǾƛŜǿƛƴƎ 
area, click the scroll arrows or drag 
the scroll bar to move the display one 
way or the other. 

Scroll  
arrows & 
scroll bar 

Minimize,  
Maximize, and  
Close buttons 
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Working in Spreadsheets 

Spreadsheets are comprised of rows and columns of data cells. To add or edit data in a cell, click the cell, 
making it the active cell, then type. Only one cell can be active at a time, and it is denoted in green. You 
can change which cell is active using the LEFT ARROW, RIGHT ARROW, PAGE UP, PAGE DOWN, HOME 
keys, etc. 

You may also select blocks of cells to work on. To select a block of cells, click and hold the mouse button 
in the first cell in the block, drag to the last cell in the block, then release the mouse. To select an entire 
row or column, simply click the row or column label. To select multiple rows or columns, click and drag 
the mouse across multiple row or column buttons. 

 

 

Column label ς Click 
the column label to 
select the entire 
column 

Scroll bar 

Row of cells ς Click the 
row label (at left) to 
select the entire row 

Column of cells 

Click any cell. Notice the Status 
bar displays an explanation of the 
current column. 
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Tutorial 1 ς Modeling 

Overview 

The four ǘǳǘƻǊƛŀƭǎ ŎƻƴǘŀƛƴŜŘ ƛƴ ǘƘƛǎ ¦ǎŜǊΩǎ DǳƛŘŜ are designed to help you explore both the spreadsheet 
and graphic drawing capabilities of RISA-2D. The tutorials demonstrate not only how you build your 
model, but also how you make changes to the model to make it more efficient, or when design 
modifications become necessary. 

The tutorials build upon themselves from start to finish. You have the option of performing them all at 
one time, or performing each one separately. To make this possible, RISA provides model files for you to 
load at the beginning of each tutorial. These starter files are located in the RISA program folder under 
Tutorials, and are named RISA-2D Tutorial 2 starter.r2d, RISA-2D Tutorial 3 starter.r2d, etc. 

In Tutorial 1, you will create a frame comprised of two steel columns supporting a wood truss. In Tutorial 
2, you will copy the frame into a 2-bay model and make modifications. Tutorial 3 will demonstrate how to 
define loads in the model. Tutorial 4 will illustrate how to run static solutions and review the results. 
When you finish all four tutorials, the final product will look like this: 

 

To complete all four tutorials will take only a few hours. However, you can speed up the process even 
further if you skip the supporting text and concentrate only on the action steps, which are indicated with 
diamond-shaped bullets, as shown below: 

 In order for you to achieve accurate results, it is important that you do not miss any of these 
action steps while performing the tutorials. 
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Starting a New File 

When you are ready to begin, start RISA-2D if you have not already done so: 

 Double-click the RISA-2D icon to start the program. The Starting a Model dialog box will display, 
which allows you to create a new model or open an existing file.  

 

You have several startup options, along with a blank drawing grid placed in the workspace. You can 
choose to start drawing your model (either by defining members, or using a template to generate it 

automatically); you can open an existing model; or you can click Close  to work on your own.  

Automatically Generating with Templates 

RISA-2D has powerful templates that automate the generation of structures. Although you will not be 
using them for the tutorials, it is helpful to know a bit about them for future use. You may access these 

templates two ways: (1) on the Starting a Model dialog box, select  Click here to use a template to 
generate a model; or, (2) on the Insert menu, click Structure(Generate). 

Some of the templates are very specific (such as the Parabolic Arc template), while others are general 
(such as the Circular Disk With Plates). Using these templates, you can generate almost any typical or 
repetitive model or model component.  

Once you complete the tutorials and learn how to build structures without the templates, you will be 
able to more easily understand how and when to use templates. This will speed up your day-to-day 
workflow and make RISA-2D even more powerful. 

  

Note: The appearance of your 
menus and toolbars may look 
slightly different, depending on 
your computer screen resolution 
and font sizes. 
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Start Modeling 

Begin creating your model by drawing members: 

 Under Create a New Model, select the Open the Global Parameters window also check box. This 
will save you a step by opening the Global Parameters dialog box after you make your starting 
selection. 

 Select  Click here to immediately start drawing members. 

Because you selected the Open Global Parameters check box option, the Global Parameters dialog box 
opens first.  

Global Parameters 

This dialog box provides access to global settings that apply to the model as a whole. 

Set the Global Parameters as follows: 

 Type a model title, company name, and your name, as shown below.  

 Click Apply. The dialog box will remain open. 

The Global Parameters dialog box: 

 

Review and modify the Solution parameters: 

 In the Global Parameters dialog box, click the Solution tab.  

 In the Number of Sections box, type 7 (or you may use the up/down arrows to increase/decrease 
the value).  

 Click Apply. 

  

Global Parameters are 
settings that apply to the 
entire model. 

Tip: Press TAB to advance to 
the next field. 

Type any notes you would 
like to keep with the model 
in the Notes box. 
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The dialog box will remain open, and should now look like this: 

 

Below is a description of all the available solution parameters: 

Number of Sections Specify how many locations along each member are to be used for the reporting 
of forces, stresses, and deflections. For this tutorial, you will specify the 
calculations be reported at 7 section locations. 

INTERNAL Sections Controls how many places along each member RISA-2D calculates and stores 
results, such as deflections and code checks. The member force diagrams 
displayed in the model view and the detail plot are also drawn from these 
results. 

Shear Deformation This check box indicates whether or not shear deformation considerations are to 
be included in the model solution. This check box is usually selected and is the 
default setting. 

Merge Tolerance Defines the maximum distance two points can be apart and still be merged 
together. It is also used when scanning for crossing members and for unattached 
joints along the spans of members. 

P-Delta Tolerance Defines the convergence tolerance for the P-Delta analysis. 

Gravity Acceleration This value is used to convert loads into masses for the purpose of a dynamic 
analysis. 

Eigensolution 
Convergence 
Tolerance 

This value is used to set how close a subsequent solution must be to the previous 
solution for a mode to be considered converged. This is used for the dynamic 
analysis solution. 
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Review the options for the Code parameters: 

 In the Global Parameters dialog box, click the Codes tab.  

For this tutorial, the default settings will be used. 

 

These settings control how code checking is performed, as described below:  

Hot Rolled 
Steel 

Code choices include AISC 360-05 (13th Ed.) ASD & LRFD, 9th Edition 
ASD, 2nd Edition LRFD, 3rd Edition LRFD, and several international steel 
codes.  

Cold Formed 
Steel 

Code choices are AISI 99: ASD & LRFD, AISI NAS-01: ASD & LRFD, and 
several international codes. 

Wood Code choices include the 97, 01, & 05 Editions of the NDS. 

Concrete Code choices include the 99, 02, 05 Editions of ACI along with several 
international codes. 

Masonry Code choices include ACI 530-05 & 02 (MSJC) ASD & Strength along with 
several international codes. 

Aluminum Code choices include AA ASM1-05 ASD (Building & Bridge). 

 

Review and modify the options for the Concrete parameters: 

 In the Global Parameters dialog box, click the Concrete tab.  

 Under Concrete Stress Options, click Parabolic Stress Block. This method is the more accurate of 
the two methods. 

 Click Apply. 
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These settings contain options related to the analysis and design of concrete members as described 
below:  

Shear Tie Options Allows you to control the number of shear regions that will be used when 
detailing a beam or column span. It also allows you to specify an increment when 
increasing or reducing the spacing of the shear ties. 

Concrete Stress 
Options 

Allows you to choose what type of stress block to consider in your analysis. The 
options are the constant Rectangular Stress Block and the Parabolic Stress Block. 
Since the parabolic block is more accurate, you will select this stress distribution 
for your design. 

Concrete check 
boxes 

Use Cracked Sections - modifies the member stiffnesses by the Icr Factor. For 
more information, refer to RISA-2D General Reference.  

Bad Framing Warnings - helps you detect modeling errors during solution. It 
produces a message in the error log whenever an unsupported member is 
detected at either of its end joints (can be common for models that contain 
cantilevers, rafters, etc.)  

Unused Force Warnings - produces messages on the member detail report when 
weak axis and torsional moments have been neglected. 

Minimum 1 Bar Dia Spacing - allows a minimum spacing of one bar diameter 
between parallel bars. Otherwise, RISA-2D will default to a two bar diameter or 
one inch clear spacing, whichever is greater, to allow for lap splices and continue 
to maintain adequate spacing between parallel bars. 

Concrete Rebar 
Set 

Allows you to specify the grade of rebar you wish to use. You can also specify a 
Minimum % Steel and Maximum % Steel for column reinforcement. 

Click Save As Defaults any time to save all 
current settings to become the new default 
settings for all future models. 

Click the Help button to open 
the Help Menu to the relavent 
topic. 
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Before closing the Global Parameters dialog box, notice you will also see a tab labeled Footings. If you 
have RISAFoot installed, this will allow you control over footing design input. If you do not have RISAFoot 
installed, this tab will only state that you need to install the program in order to utilize the integration. 
For more information on this integration, please click Help or refer to RISA-2D General Reference Manual. 

You may now close the Global Parameters dialog box. 

 Click OK to exit.  

Members 

Once you close the Global Parameters dialog box, the Draw Members dialog box will display: 

 

Before drawing the members, first define the material type to be used, either: Hot Rolled, Cold Formed, 
Wood, Concrete, Aluminum, or General. Once the materials are stored in RISA-2D, the spreadsheets and 
solution results will be sorted based on that material. When performing a solution, RISA-2D will only 
analyze and/or design members for load combinations that are appropriate for that material (this will be 
discussed in more detail in Tutorial 3 ς Loading). 

Define Hot Rolled Steel as the material type for the new members you will be creating: 

 Under Member Material Type and Shape, click Hot Rolled. 

Next, you need to decide how you want to define the cross-sectional properties of the member. You can 
assign a shape directly, or define your properties based on section sets.  

For now, start with a 12x53 column, and assign your concrete shapes directly. (Later you will use section 
sets for your wood truss and concrete members.) 

 Click Assign Shape Directly.  
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This bypasses the section sets and allows you to assign an explicit shape for these new members: 

 Under Start Shape, highlight and type W12x53. 

 Under Design List, select Wide Flange. 

 Under Material, select A992. 

 Under Type, select Column. 

The dialog box should now look like this: 

 

Verify the settings, then prepare to start drawing: 

 Click Apply. 

Note: After you click Apply, your cursor changes to , indicating that you are now in the drawing 

mode. Also notice that on the Drawing toolbar, the Draw New Members  button is pressed in. 

  

The release codes are used to 
designate whether the forces and 
moments at the ends of the 
member are considered fixed to or 
released from the member's points 
of attachment (the end joints). 
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Drawing Grid 

Before you begin drawing, notice that RISA-2D will always open a default 30x30 grid spaced at one foot. 
To make it easier to find your column and beam locations for this tutorial, redefine the grid as follows: 

 On the Drawing toolbar, click the Modify Drawing Grid button to redefine the grid. The 
Drawing Grid tab should already be selected. 

Change the grid increments as follows:  

 Under Rectangular Grid Increments, in the first column under X Axis, highlight and delete any 
current data and type: 3,4@3.75,3 (including the commas).  

 In the first column under Y Axis, highlight and delete any current data and type: 10,8.5,4 
(including the commas). 

The dialog box should now look like this: 

 

Close the Drawing Grids dialog box and the Data Entry toolbar. 

 Click OK to close the dialog box.  

 Click Close  to close the Data Entry toolbar (upper right corner of your workspace). 

  

These settings define a drawing grid with an initial 
X-increment for the truss points of 3 ft, followed by 
4 equal increments of 3.75 ft each (denoted by the 
άϪέ ǎȅƳōƻƭύΣ ŀƴŘ ŀ Ŧƛƴŀƭ ƛƴŎǊŜƳŜƴǘ ƻŦ о Ŧǘ.  

Other options available: you may specify a 
radial grid, you may save the grid layout to 
use in other models, and you may make this 
the default grid layout. 


























































































































































































































